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Egal wie lange Sie schon mit Microsoft Word arbeiten, es gibt immer 
neue und brauchbare Dinge zu entdecken um die Arbeit schneller und 
effizienter zu erledigen. Im folgenden finden Sie einige Techniken 
gegliedert in 3 Abschnitten: Basics, Advanced Tips, and Was Sie sich 
ersparen können. Die meisten Tipps stammen von TechRepublic, einer 
Abteilung des Ziff-Davis-Verlags (www.techrepublic.com) und von 
Microsoft . 

 
Basics 

 
 Verwenden Sie die “Rückgängig”-Funktion [Undo]. Haben Sie 

einen Fehler gemacht? Kein Problem – drücken Sie [Strg]Z oder 
wählen Sie Rückgängig aus dem Bearbeiten-Menü. Um mehrere 
Aktionen in einem Schritt rückgängig zu machen, klicken Sie auf den 
Pfeil neben dem Rückgängig-Symbol in der Standard-Symbolleiste, 
und klicken Sie dann auf die Aktionen, die rückgängig gemacht 
werden sollen. Hinweis: Nicht alle Aktionen können rückgängig 
gemacht werden. 

 Speichern Sie Ihre Arbeit auch zwischendurch. Verwenden Sie 
[Strg]S oder drücken Sie das Speichern-Symbol auf der Standard-
Symbolleiste. Auf Wunsch kann Word Ihre Dateien auch automatisch 
in regelmäßigen Abständen speichern. Dazu öffnen Sie das Extras-
Menü, wählen Optionen und dort die Kartei Speichern; Bei Auto-
Wiederherstellen können Sie ein Zeitintervall zwischen 1 und 120 
Minuten wählen. 

 Bewegen im Dokument. Um zum Anfang eines Dokuments zu 
gelangen drücken Sie  [Strg][Pos1], Zum Dokumentenende kommen 
Sie mit [Strg][Ende]. Zum Beginn der nächsten Seite geht es mit 
[Strg][Bild ↓], zum Beginn der vorherigen Seite mit [Strg][Bild ↑]. 
[Strg]G (Menü Bearbeiten  GeheZu) öffnet ein Dialogfenster, in 
dem Sie eine Seite, einen Abschnitt u.a.m. komfortabel auswählen 
können. Word speichert die letzten drei Stellen, an denen Text 
eingegeben oder bearbeitet wurde. Um zu einer zuvor bearbeiteten 
Stelle zurückzukehren, halten Sie UMSCHALT+F5 gedrückt, bis Sie 
die gewünschte Stelle erreicht haben. 

 Arbeiten mit Menüs und Ausführen von Befehlen mit der 
Tastatur. Drücken Sie die [Alt]-Taste in Kombination mit  dem 
unterstrichenen Buchstaben (Daten, Bearbeiten, Ansicht, Einfügen, 
Format, ....). Wenn einMenü geöffnet ist, reicht es aus den 
unterstrichenen Buchstaben des gewünschten Befehl zu drücken. 
Hier einige Beispiele: [Alt]D, h. Speichern unter: [Alt]D, u. Öffnen des 
zuletzt verwendeten Dokuments: [Alt]D,1. 

 Vier Wege um einen Textblock zu markieren 
1. Mit der Maus: linke Taste klicken und den gewünschten Text 

markieren. 
2. Verwenden Sie die [Umschalt]-Taste in Verbindung mit den 

Pfeiltasten. Drücken von [Strg][Umschalt] in Verbindung mit den 
Pfeiltasten markiert ganze Wörter. 

Feldfunktion geändert
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3. Kombinieren Sie Maus und [Umschalt]-Taste. Bewegen Sie den 
Mauszeiger , halten Sie die [Umschalt]-Taste gedrückt, und der 
Text zwischen Cursorposition und Mauszeiger wird markiert. 

4. Wenn der zu  markierende Text unterhalb der am Bildschirm 
sichtbaren Seite ist, sollten Sie die [Umschalt]-Taste mit dem 
Pfeiltasten verwenden. 

 Markieren eines Wortes geht mit einem Doppelklick. Ein 
nachfolgendes Leerzeichen wird mit markiert. 

 Markieren eines Satzes. Drücken Sie [Strg] and klicken Sie 
irgendeine Stelle im Satz an. In der Folge könne Sie das Format 
ändern, den Satz löschen, verschieben, die Rechtschreibung 
überprüfen.... 

 Markieren eines Absatzes geht mit einem Dreifachklick. Alternativ 
können Sie die Maus links vom Absatz positionieren, und mit einem 
Klick eine Zeile, mit einem Doppelklick den ganzen Absatz markieren 

 Markieren einer Tabelle. Drücken Sie [Alt] in Verbindung mit einem 
Doppelklick. 

 Markieren von Text zwischen Cursor und … Um den Text 
zwischen Cursorund dem Ende der aktuellen Zeile zu markieren 
drücken Sie [Umschalt][Ende]. Zum Markieren des Textes bis zum 
Ende des aktuellen Absatzes drücken [Strg][Umschalt] und die 
Pfeiltaste ↓. Zum Markiren bis zum Ende des Dokuments drücken Sie 
[Strg][Umschalt][Ende]. 

 Markieren des gesamten Dokuments. Drücken Sie [Strg]A. Diese 
Funktion ist brauchbar, wenn Sie Schriftart oder 
Formateigenschaften im gesamten Dokument ändern oder löschen 
möchten. Wenn Sie z.B. einige Textpassagen unterstrichen haben 
und diese Formatierung entfernen möchten, ist es einfacher das 
gesamte Dokument mit [Strg]A zu markieren, mit [Strg]U die 
Unterstreichung im gesamten Dokument zu aktivieren und mit [Strg]U 
alle Unterstreichungen zu löschen. Vorsicht: Wenn Sie nach [Strg]A 
unabsichtlich die Return oder Löschtaste drücken, wird der gesamte 
markierte Text gelöscht. Verwenden Sie [Strg]Z oder die Funktion 
Rückgängig im Menü Bearbeiten. 

 Schrift vergrößern oder verkleinern. Diese Funktion könne Sie 
über das Menü Format-Zeichen, dem Kontextmenü (erreichbar über 
die rechte Maustaste), Einstellung der Schriftgröße in der 
Symbolleiste Format verwenden. Mit der Tastatur können Sie durch 
Kombination der Steuerungstaste und den eckigen Klammern [Strg] [ 
bzw [Strg] 9 die Zeichengröße verändern. 

 Verwenden Sie die passende Ansicht (Menü Ansicht). Die 
Ansicht Seitenlayout entspricht weitgehend dem Druck. Die Ansicht 
Normal ist dann zu bevorzugen, wenn Sie ein mit sehr langen 
Dokumenten arbeiten oder einen langsamen Computer haben. 

 Briefumschläge bedrucken. Schreiben Sie eine Adresse in einem 
neuen Dokument oder markieren Sie eine Adresse in einem Brief. Im 
Menü Extras wählen Sie Umschläge und Etiketten. Beachten Sie 
dabei die Größe des Umschlags und die Druckrichtung (einstellbar in 
den Optionen des Umschläge Menüs) 

 Benutzen Sie die rechte Maustaste. Dieses Kontextmenü bietet 
brauchbare und häufig genutzte Formatierungsoptionen an. 
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 Text ohne Formatierung einfügen. Wenn Sie Text aus dem 
Internet oder aus andern Dokumenten einfügen wird die dort 
verwendete Formatierung ebenfalls miteingefügt. Mit dem Menüpunkt 
Bearbeiten – Inhalte einfügen – unformatierter Text wird nur der Text 
übernommen. 

 
Advanced Tips 

 
 Sofortige AutoKorrektur. Klicken Sie mit der rechten Maustaste auf 

ein Wort, das von Word als mit einer roten Wellenlinie als inkorrekt 
markiert wird (Die Option Rechtschreibung während der Eingabe 
überprüfen muss dazu aktiviert sein). Im Untermenu Autokorrektur 
können Sie die Änderungen speichern und so Ihre “Lieblingsfehler” 
automatisch korrigieren lassen 

 
 Leerzeilenhöhe genau einstellen. Wenn Sie die 

Seitenlänge optimal ausnutzen wollen, können Sie If you're 
trying to squeeze extra text on a page, you don't have to 
open the Format menu. You can fine-tune the vertical 
space a blank line occupies between lines of text. Select 
the paragraph mark in the blank line and use the [Strg]] 
(Grow Font) or [Strg][ (Shrink Font) shortcuts to increase 
or decrease the size of the paragraph mark, thereby 
increasing or decreasing the height of the blank line. 

 
 Effortless AutoText. Save time by inserting AutoText 

automatically. Type an entry name and press [F3]. Or take 
advantage of Word's AutoComplete feature. Just open the 
Tools menu, select AutoCorrect, click the AutoText tab, 
and turn on the Show AutoComplete Tip For AutoText And 
Dates option. With this feature active, Word will show a 
ScreenTip after you begin typing an AutoText item. Just 
press [Enter] and Word will insert the item for you. (This 
feature works the same way with dates and days of the 
week.) 

 
 Marker display. Work with paragraph markers and tabs 

displayed. Simply click the Show/Hide ¶ button on the 
Standard toolbar. Displaying those normally hidden 
characters helps you avoid inadvertently deleting objects 
or changing formatting; it also helps you figure out funky 
alignment and extra white space problems. 

 
 Use AutoCorrect as a text expander. You don't have to 

keep typing those long words or phrases you have trouble 
with. Come up with a three or four-letter abbreviation for it 
and add it to AutoCorrect. For example, say you often 
need to type Indianapolis. Press [Alt]T (to open the Tools 
menu) and press A to select AutoCorrect. Type indy, press 
[Tab], type Indianapolis, and press [Enter] twice. Now, any 
time you type indy followed by a space or any punctuation, 
Word will "automatically correct" that spelling and replace it 
with Indianapolis. You can save up to 255 characters in an 
AutoCorrect entry. (If you need more characters or you 
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want to include pictures along with text, use AutoText 
instead.) 

 
 Clear a table. If you need to delete the contents of all the 

cells in a table, just select the table and press [Delete] (not 
[Backspace]). 

 
 Display built-in styles. When you create a document, 

Word starts you out with five basic styles. If you need to 
apply a more specialized style, hold down [Shift] and click 
on the arrow beside the Style box. Word will expand the 
Style list to include all its built-in styles. Just select the one 
you need and Word will apply that style and add it to your 
document. 

 
 Quick table column total. Put the cursor in the last cell in 

a column of numbers. Open the Table menu, select 
Formula, and press [Enter] to accept the default Sum 
function. 

 
 Styles as you go. Define styles on the fly: Format a 

paragraph the way you want, type a name in the Style box, 
and press [Enter]. 

 
 Quick Field Toggle. Press [Alt][F9] to quickly toggle field 

code display on and off. 
 

 Add a border to a page. To add a border to page (like we 
did in this document), open the Format menu, select the 
Borders and Shading option, and click the Page Border 
tab. 

 Faster Go To. Double-click the left end of the status bar to 
bring up the Go To tab so you can jump to an item in your 
document such as bookmark, a specific page, a table, a 
section, and so on. 

 
 Splitsville. See two parts of a document at the same time 

by choosing Split from the Window menu and clicking to 
place the split bar where you want to divide the document 
window. Separate vertical scroll bars allow you to bring 
different portions of text into view—and you can set 
different view preferences for each pane (such as normal 
view in the top pane and page layout in the bottom). To 
restore the panes to a single window, just double-click the 
split bar or drag it beyond the top or bottom of the window. 

 
 Selective word count. Need to know how many words, 

characters, paragraphs, or lines appear in a portion of a 
document? Just select the text you want to run the count 
on prior to choosing Word Count from the Tools menu. 

 
 Trimming ragged text by turning on hyphenation. 

When text contains many long words and your left and 
right margins are close to one another, your right margin 
can look ragged. To help smooth out that edge, choose 
Language from the Tools menu, select Hyphenation, click 
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in the Automatically Hyphenate Document check box, and 
click OK. 

 
 Copy formatting to more than one block of text. To 

copy the formatting from the current word or paragraph, 
click the Format Painter button on the Standard toolbar 
and then select the word or block of text to which you want 
to apply that formatting. To copy the same formatting to 
more than one block of text, double-click on the Format 
Painter. Then you can apply the formatting to several 
different blocks of text. To turn off the Format Painter, just 
click it or press [Esc]. 

 
 Jump quickly between documents. If you work with a lot 

of open, overlapping documents, here's a quick way to 
cycle between them: Press [Strg][F6] to jump from one to 
the next; [Strg][Shift][F6] will jump you backward. 

 
 Insert and format symbols. For instant access to 

thousands of special symbols, like foreign characters and 
wild and crazy icons, open the Insert menu, choose 
Symbol, and look through the selections available with 
different fonts and subsets of fonts. After you insert a 
special character or symbol, you can then select it and use 
[Grow Font] and [Shrink Font] on it! 

 
 Create a desktop shortcut to a document. To create a 

document shortcut, first highlight some text to serve as a 
target in the document and click the Copy button. Next, 
minimize the Word window or drag it out of the way so you 
can see the Windows desktop. Then, right-click on the 
desktop and choose Paste Shortcut. You'll probably want 
to change the shortcut name to something more 
meaningful. To do this, click on the shortcut to select it and 
then press [F2] to activate the label for editing. Type the 
desired name and press [Enter]. Close your document, 
clicking Yes to save your changes. You can even exit 
Word, if you want. Then simply double-click on the desktop 
shortcut. Word will open the associated document, 
navigate to your target text, and select it. 

 
Things You Don't Have to Do 

 
 Worry. You don't have to worry about doing something 

wrong. Just get familiar with the program and experiment 
with Word features. If something looks wrong or funny, 
that's when you use the Undo feature. Press or type the 
wrong thing, try [Strg]Z to undo whatever you did. Always 
remember you can press [Strg]Z or choose Undo from the 
Edit menu to undo changes one at a time. Aside from 
deleting a file or failing to save a file, there's almost nothing 
you can do that isn't reversible. 

 
 Use Microsoft's conventions. You don't have to use the 

term "insertion point." Just call it the cursor. That blinking 
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thing that tells you where the stuff you type goes. Anything 
but "insertion point." 

 
 Move your hands from the keyboard. You don't have to 

use the mouse to do things like open menus, select or 
format text, or move the cursor. You may find you work 
more efficiently if you're not always moving your hand from 
the keyboard to the mouse. Press [Home] to move to the 
beginning of the current line, [End] to move to the end of 
the current line. Press [Strg] and the left or right arrow to 
move one word in either direction. Hold down [Shift] while 
pressing those keys to select the text between the cursor 
and the beginning or the end of the line, respectively. 

 
 Select the entire paragraph to change formatting or 

style. You don't have to select the entire paragraph to 
change the paragraph's formatting or style. Just click 
anywhere in the paragraph and choose the desired format 
or style. A good example is justification. Just click 
anywhere in the paragraph, then click the Align Left, Align 
Right, or Justify button on the Standard toolbar. 

 
 Work in one document at a time. You don't have to close 

one Word document before you open another. Open as 
many at a time as you want to. Use the [Strg][F6] keyboard 
shortcut or the Windows menu to move quickly between 
open documents.  

 
 Risk missing something you're looking for. You don't 

have to visually scan and manually scroll through a 
document looking for a word or phrase. Use [Strg]F to 
open the Find tab, and let Word locate the text for you. 

 
 Waste time during spelling check. You don't have to 

repeatedly click Ignore or Ignore All every time the spell-
checker stops on a proper noun or a term that's commonly 
used in your documents. Click Add so you don't waste time 
checking the same words over and over. 

 
 Delete old text you're replacing. If you're selecting a big 

block of text that you're planning to replace with new text, 
you don't have to delete the old text first. Select the old text 
and start typing the new text. The first keystroke replaces 
the old selected text. Don't waste time pressing [Delete] 
first. 

 
 Press [Backspace] over and over. You don't have to 

press [Backspace] a dozen times to delete a word or 
phrase. If you type something and then change your mind, 
pressing [Strg][Backspace] to delete a word at a time is 
much faster than pressing [Backspace] over and over 
again. There's only one thing more wasteful: using the 
mouse to click on the beginning of the word or phrase and 
then pressing [Delete] repeatedly. If you get overzealous 
with [Strg][Backspace] and delete one word too many, 
press [Strg]Z to bring it right back. 
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Noch ein Tip zum Drucken einer Liste von Tastenkombinationen: 

1. Zeigen Sie im Menü Extras auf Makro, und klicken Sie dann auf 
Makros.  

2. Klicken Sie im Feld Makros in auf Word-Befehlen. 
3. Klicken Sie im Feld Makroname auf BefehleAuflisten. 
4. Klicken Sie auf Ausführen. 
5. Klicken Sie im Dialogfeld Befehle auflisten auf Aktuelle Menü- und 

Tastatureinstellungen. 
6. Klicken Sie im Menü Datei auf Drucken. 

 
Credits 

 
Diese Tips wurden zusammengestellt von Jeff Davis, Jody 
Gilbert, and Travis Frazier (TechRepublic) und ergänzt von 
Josef Haas. 
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Tastenkombinationen in Windows 
Tastenkombination Zweck 

STRG + Esc Anzeigen des Start-Menüs (entspricht der 
Windows-Logo-Taste 

Alt Esc und Alt Umschalt 
Esc 

Umschalten zwischen offenen Programmen 

Alt Tab Umschalten zwischen offenen Programmen, 
zeigt die Symbole der offenen Programme an 

STRG+F6 und STRG 
Umschalt F6 

Umschalten zwischen mehreren offenen 
Dokumente in einem Programm z.B. in Word 

Umschalt Entf Endgültige Löschen einer Datei – die Datei 
wird nicht in den Papierkorb verschoben 

STRG+A  Alles auswählen  

 Tastenkombinationen in Word 
2000 
Text und Grafiken löschen 

Tastenkombination Zweck 

RÜCKTASTE Zeichen links neben der Einfügemarke löschen 

STRG+RÜCKTASTE Wort links neben der Einfügemarke löschen 

ENTF Zeichen rechts neben der Einfügemarke 
löschen 

STRG+ENTF Wort Zeichen rechts neben der Einfügemarke 
löschen 

STRG+X Markierten Text in die Zwischenablage 
verschieben 

STRG+Z  Letzte Aktion rückgängig machen 

STRG+F3 In die Sammlung verschieben 
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Text und Grafiken kopieren und verschieben 

Tastenkombination Zweck 

STRG+C Text oder Grafiken kopieren 

STRG+C, STRG+C Zwischenablage anzeigen 

F2 (danach Verschieben der 
Einfügemarke und Drücken der 
EINGABETASTE) 

Text oder Grafiken verschieben 

STRG+V Inhalt der Zwischenablage einfügen 

STRG+UMSCHALT+F3 Inhalt der Sammlung einfügen 

ALT+UMSCHALT+R Die Kopf- oder Fußzeile aus dem 
vorherigen Abschnitt des Dokuments 
kopieren 

  

Sonderzeichen einfügen 

Tastenkombination Einzufügendes Element 

STRG+F9 Feld 

EINGABETASTE (nach Eingabe der 
ersten Zeichen des Namens des 
AutoText-Eintrags und Anzeige des 
Bildschirmtipps) 

AutoText-Eintrag 

UMSCHALT+EINGABE Zeilenwechsel 

STRG+EINGABE Seitenwechsel 

STRG+UMSCHALT+EINGABE Spaltenwechsel 

STRG+BINDESTRICH Bedingter Bindestrich 

STRG+UMSCHALT+BINDESTRICH Geschützter Trennstrich 

STRG+UMSCHALT+LEERTASTE Geschütztes Leerzeichen 

ALT+STRG+C Copyright-Symbol 

ALT+STRG+R Symbol für eingetragene Marke 

ALT+STRG+T Marken-Symbol 

ALT+STRG+Punkt Auslassungspunkte 
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Text und Grafiken markieren 

Markieren Sie Text, indem Sie die UMSCHALTTASTE gedrückt halten und 
dann die entsprechende Pfeiltaste verwenden. 

Tastenkombination Erweiterung der Markierung 

UMSCHALT+NACH-RECHTS Um ein Zeichen nach rechts 

UMSCHALT+NACH-LINKS Um ein Zeichen nach links 

STRG+UMSCHALT+NACH-RECHTS Bis zum Wortende 

STRG+UMSCHALT+NACH-LINKS Bis zum Wortanfang 

UMSCHALT+ENDE Bis zum Zeilenende 

UMSCHALT+POS1 Bis zum Zeilenanfang 

UMSCHALT+NACH-UNTEN Um eine Zeile nach unten 

UMSCHALT+NACH-OBEN Um eine Zeile nach oben 

STRG+UMSCHALT+NACH-UNTEN Bis zum Absatzende 

STRG+UMSCHALT+NACH-OBEN Bis zum Absatzanfang 

UMSCHALT+BILD-AB Um eine Bildschirmseite nach unten 

UMSCHALT+BILD-AUF Um eine Bildschirmseite nach oben 

STRG+UMSCHALT+POS1 Bis zum Dokumentenanfang 

STRG+UMSCHALT+ENDE Bis zum Dokumentenende 

ALT+STRG+UMSCHALT+BILD-AB Bis zum Ende eines Fensters 

STRG+A Um das gesamte Dokument 

STRG+UMSCHALT+F8 und 
anschließendes Verwenden der 
Pfeiltasten; um den Markierungsmodus 
aufzuheben, drücken Sie ESC 

Um einen vertikalen Textblock 

F8+Pfeiltasten; um den 
Markierungsmodus aufzuheben, drücken 
Sie ESC 

Bis zu einer bestimmten Position im 
Dokument 

  
Tipp   Wenn Ihnen die Tastenkombination zum Verschieben der Einfügemarke 
bekannt ist, können Sie im Allgemeinen mit derselben Tastenkombination und 
gleichzeitig gedrückter UMSCHALTTASTE den Text markieren. Die 
Tastenkombination STRG+NACH-RECHTS beispielsweise verschiebt die 
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Einfügemarke zum nächsten Wort und STRG+UMSCHALT+NACH-RECHTS 
markiert den Text von der Einfügemarke an bis zum Anfang des nächsten Wortes. 

Text und Grafiken in einer Tabelle markieren 

Tastenkombination Zweck 

TAB Inhalt der nächsten Zelle markieren 

UMSCHALT+TAB Inhalt der vorherigen Zelle markieren 

Halten Sie die UMSCHALTTASTE 
gedrückt, und drücken Sie wiederholt 
auf eine der Pfeiltasten 

Markierung auf angrenzende Zellen 
erweitern 

Klicken Sie auf die obere oder untere 
Zelle der Spalte, und drücken Sie 
wiederholt die NACH-OBEN- oder 
NACH-UNTEN-TASTE 

Spalte markieren 

Drücken Sie STRG+UMSCHALT+F8, 
und verwenden Sie dann die Pfeiltasten; 
um den Markierungsmodus aufzuheben, 
drücken Sie ESC 

Markierung (oder Block) erweitern 

UMSCHALT+F8 Markierungsumfang verkleinern 

ALT+5 auf der Zehnertastatur (bei 
deaktivierter NUM-TASTE) 

Gesamte Tabelle markieren 

  

Markierung erweitern 

Tastenkombination Zweck 

F8 Erweiterungsmodus aktivieren 

Drücken Sie F8 und dann die NACH-
LINKS- oder NACH-RECHTS-TASTE 

Nächstes Zeichen markieren 

F8 (einmal zur Markierung eines 
Wortes, zweimal zur Markierung eines 
Satzes usw.) 

Markierung vergrößern 

UMSCHALT+F8 Markierung verkleinern 

ESC Erweiterungsmodus deaktivieren 

  

Einfügemarke verschieben 

Tastenkombination Richtung 
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NACH-LINKS-TASTE Ein Zeichen nach links 

NACH-RECHTS-TASTE Ein Zeichen nach rechts 

STRG+NACH-LINKS Ein Wort nach links 

STRG+NACH-RECHTS Ein Wort nach rechts 

STRG+NACH-OBEN Ein Absatz nach oben 

STRG+NACH-UNTEN Ein Absatz nach unten 

UMSCHALT+TAB Eine Zelle nach links (in einer Tabelle) 

TAB Eine Zelle nach rechts (in einer Tabelle) 

NACH-OBEN-TASTE Eine Zeile nach oben 

NACH-UNTEN-TASTE Eine Zeile nach unten 

ENDE An das Zeilenende 

POS1 An den Zeilenanfang 

ALT+STRG+BILD-AUF An den oberen Rand des Fensters 

ALT+STRG+BILD-AB  An den unteren Rand des Fensters 

BILD-AUF Eine Bildschirmseite aufwärts (Bildlauf) 

BILD-AB Eine Bildschirmseite abwärts (Bildlauf) 

STRG+BILD-AB An den Anfang der nächsten Seite 

STRG+BILD-AUF An den Anfang der vorherigen Seite 

STRG+ENDE An das Ende des Dokuments 

STRG+POS1 An den Anfang des Dokuments 

UMSCHALT+F5 Zur letzten Bearbeitungsstelle 

UMSCHALT+F5 An die Position der Einfügemarke beim letzten 
Schließen des Dokuments 

  

Zwischen verschiedenen Tabellenteilen wechseln 

Tastenkombination Wechseln zu 

TAB Nächste Zelle in einer Zeile 

UMSCHALT+TAB Vorherige Zelle in einer Zeile 

ALT+POS1 Erste Zelle in einer Zeile 
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ALT+ENDE Letzte Zelle in einer Zeile 

ALT+BILD-AUF Erste Zelle in einer Spalte 

ALT+BILD-AB Letzte Zelle in einer Spalte 

NACH-OBEN-
TASTE 

Vorherige Zeile 

NACH-UNTEN-
TASTE 

Nächste Zeile 

  

Absätze und Tabstoppzeichen in eine Tabelle einfügen 

Tastenkombination Einzufügende Elemente  

EINGABETASTE Neue Absätze in eine Zelle 

STRG+TAB Tabstoppzeichen in eine Zelle 

  
Tastenkombinationen 

Arbeiten mit Dokumenten 

Beschreibung Was ist zu tun ? 

Neues Dokument erstellen STRG+N 

Dokument öffnen STRG+O 

Dokument schließen STRG+W 

Dokument teilen ALT+STRG+S 

Dokument speichern STRG+S 

Word beenden ALT+F4 

Beschreibung Was ist zu tun ? 

Nach Text, Formatierung und Sonderzeichen 
suchen 

STRG+F 
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Weitersuchen ALT+STRG+Y 

Text, Formatierung und Sonderzeichen ersetzen STRG+H 

Zu einer Seite, Textmarke, Fußnote, Tabelle, 
einem Kommentar, einer Grafik oder einen 
anderen Stelle im Dokument wechseln 

STRG+G 

Zu einer Seite, Textmarke, Fußnote, Tabelle, 
einem Kommentar, einer Grafik oder einer 
anderen Stelle im Dokument zurückkehren 

ALT+STRG+Z 

Dokument durchsuchen ALT+STRG+POS1 

Beschreibung Was ist zu tun ? 

Aktion abbrechen ESC 

Aktion rückgängig machen STRG+Z 

Aktion wiederherstellen oder wiederholen STRG+Y 

Beschreibung Was ist zu tun ? 

Wechseln zur Layout-Ansicht ALT+STRG+L 

Wechseln zur Gliederungsansicht ALT+STRG+G 

Wechseln zur Normalansicht ALT+STRG+N 

Wechseln zwischen einem Zentraldokument und 
den Filialdokumenten 

STRG+\ 

Formatieren von Zeichen und Absätzen 

Formatieren von Zeichen 
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Beschreibung Was ist zu tun ? 

Schriftart ändern STRG+UMSCHALT+A 

Schriftgrad ändern STRG+UMSCHALT+P 

Schriftgrad vergrößern  STRG+UMSCHALT+> 

Schriftgrad verkleinern STRG+< 

Schriftgrad um 1 Punkt vergrößern STRG+9 

Schriftgrad um 1 Punkt verkleinern STRG+8 

Beschreibung Was ist zu tun ? 

Zeichenformatierung ändern (Befehl Zeichen, 
Menü Format) 

STRG+D 

Groß-/Kleinschreibung der Buchstaben ändern UMSCHALT+F3 

Buchstaben als Großbuchstaben formatieren STRG+UMSCHALT+G 

Text fett formatieren STRG+ UMSCHALT+F 

Text unterstreichen STRG+ UMSCHALT+U 

Lediglich Wörter (keine Leerzeichen) 
unterstreichen 

STRG+UMSCHALT+W 

Text doppelt unterstreichen STRG+UMSCHALT+D 

Text verborgen formatieren STRG+UMSCHALT+H 

Text kursiv formatieren STRG+UMSCHALT+K 



 

J. Haas Seite 16 von 35 

Buchstaben in Kapitälchen formatieren STRG+UMSCHALT+Q 

Tiefgestellt-Formatierung zuweisen 
(automatischer Abstand) 

STRG+# 

Hochgestellt-Formatierung zuweisen 
(automatischer Abstand) 

STRG+UMSCHALT+PLUS 

Manuelles Zeichenformat entfernen STRG+LEERTASTE 

Dem markierten Text die Symbol-Schriftart 
zuweisen 

STRG+UMSCHALT+B 

Beschreibung Was ist zu tun ? 

Nichtdruckbare Zeichen anzeigen STRG+UMSCHALT+* (Sternchen) 

Textformatierung überprüfen UMSCHALT+F1 (danach auf den Text klicken, 
dessen Formatierung Sie überprüfen möchten) 

Formate kopieren STRG+UMSCHALT+C 

Formate einfügen STRG+UMSCHALT+V 

Formatieren von Absätzen 

Beschreibung (Gewünschter Zeilenabstand) Was ist zu tun ? 

Einfacher Zeilenabstand STRG+1 

Doppelter Zeilenabstand STRG+2 

1,5-facher Zeilenabstand STRG+5 

Zeile vor einem Absatz hinzufügen oder entfernen STRG+0 (Null) 



 

J. Haas Seite 17 von 35 

Beschreibung (Absatzausrichtung und 

Einzüge) 
Was ist zu tun ? 

Absatz zentrieren STRG+E 

Absatz im Blocksatz ausrichten STRG+B 

Absatz linksbündig ausrichten STRG+L 

Absatz rechtsbündig ausrichten STRG+R 

Absatz von links einziehen STRG+M 

Absatzeinzug von links entfernen STRG+UMSCHALT+M 

Hängenden Einzug erstellen STRG+T 

Hängenden Einzug verkleinern STRG+UMSCHALT+T 

Absatzformatierung entfernen STRG+Q 

Beschreibung (Zuweisen v. Formatvorlagen) Was ist zu tun ? 

Formatvorlage zuweisen  STRG+UMSCHALT+S 

AutoFormat starten STRG+J 

Formatvorlage Standard zuweisen STRG+UMSCHALT+N 

Überschrift-Formatvorlage Überschrift 1 zuweisen ALT+1 

Überschrift-Formatvorlage Überschrift 2 zuweisen ALT+2 

Überschrift-Formatvorlage Überschrift 3 zuweisen ALT+3 

Formatvorlage Liste zuweisen STRG+UMSCHALT+L 
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Bearbeiten und Verschieben von Text und Grafiken 

Löschen von Text und Grafiken  

Beschreibung Was ist zu tun ? 

Zeichen links neben der Einfügemarke löschen RÜCKTASTE 

Wort links neben der Einfügemarke löschen STRG+RÜCKTASTE 

Zeichen rechts neben der Einfügemarke löschen ENTF 

Wort Zeichen rechts neben der Einfügemarke 
löschen 

STRG+ENTF 

Markierten Text in die Zwischenablage 
verschieben 

STRG+X 

Letzte Aktion rückgängig machen STRG+Z  

In die Sammlung verschieben STRG+F3 

Kopieren und Verschieben von Text und Grafiken  

Beschreibung Was ist zu tun ? 

Text oder Grafiken kopieren STRG+C 

Text oder Grafiken verschieben F2 (danach Verschieben der Einfügemarke und 
Drücken der EINGABETASTE) 

AutoText erstellen ALT+F3 

Inhalt der Zwischenablage einfügen STRG+V 

Inhalt der Sammlung einfügen STRG+UMSCHALT+F3 

Einfügen von Sonderzeichen 
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Beschreibung (Einzufügendes Element) Was ist zu tun ? 

Feld STRG+F9 

AutoText-Eintrag EINGABETASTE (nach Eingabe der ersten 
Zeichen des Namens des AutoText-Eintrags und 
Anzeige der QuickInfo) 

Zeilenwechsel UMSCHALT+EINGABE 

Seitenwechsel STRG+EINGABE 

Spaltenwechsel STRG+UMSCHALT+EINGABE 

Bedingter Bindestrich STRG+BINDESTRICH 

Geschützter Bindestrich STRG+UMSCHALT+BINDESTRICH 

Geschütztes Leerzeichen STRG+UMSCHALT+LEERTASTE 

Copyright-Symbol ALT+STRG+C 

Symbol für eingetragene Marke ALT+STRG+R 

Marken-Symbol ALT+STRG+T 

Auslassungspunkte ALT+STRG+Punkt 

Markieren von Text und Grafiken 

Markieren Sie Text, indem Sie die UMSCHALTTASTE gedrückt halten und dann die 
entsprechende Pfeiltaste verwenden. 

Beschreibung (Erweiterung der Markierung) Was ist zu tun ? 

Um ein Zeichen nach rechts UMSCHALT+NACH-RECHTS 
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Um ein Zeichen nach links UMSCHALT+NACH-LINKS 

Bis zum Wortende STRG+UMSCHALT+NACH-RECHTS 

Bis zum Wortanfang STRG+UMSCHALT+NACH-LINKS 

Bis zum Zeilenende UMSCHALT+ENDE 

Bis zum Zeilenanfang UMSCHALT+POS1 

Um eine Zeile nach unten UMSCHALT+NACH-UNTEN 

Um eine Zeile nach oben UMSCHALT+NACH-OBEN 

Bis zum Absatzende STRG+UMSCHALT+NACH-UNTEN 

Bis zum Absatzanfang STRG+UMSCHALT+NACH-OBEN 

Um eine Bildschirmseite nach unten UMSCHALT+BILD-AB 

Um eine Bildschirmseite nach oben UMSCHALT+BILD-AUF 

Bis zum Ende eines Fensters ALT+STRG+BILD-AB 

Bis zum Dokumentenanfang STRG+UMSCHALT+POS1 

Um das gesamte Dokument STRG+A 

Um einen vertikalen Textblock STRG+UMSCHALT+F8 und anschließendes 
Verwenden der Pfeiltasten; um den 
Markierungsmodus aufzuheben, drücken Sie 
ESC 

Bis zu einer bestimmten Position im Dokument F8+Pfeiltasten; um den Markierungsmodus 
aufzuheben, drücken Sie ESC 

Tip Wenn Ihnen die Tastenkombination zum Verschieben der Einfügemarke bekannt ist, 
können Sie mit derselben Tastenkombination und gleichzeitig gedrückter 
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UMSCHALTTASTE den Text markieren. Die Tastenkombination STRG+NACH-RECHTS 
beispielsweise verschiebt die Einfügemarke zum nächsten Wort und 
STRG+UMSCHALT+NACH-RECHTS markiert den Text von der Einfügemarke an bis zum 
Anfang des nächsten Wortes. 

Markieren von Text und Grafiken in einer Tabelle  

Beschreibung Was ist zu tun ? 

Markieren des Inhaltes der nächsten Zelle TAB 

Markieren des Inhaltes der vorherigen Zelle UMSCHALT+TAB 

Erweitern der Markierung auf angrenzende Zellen Halten Sie die UMSCHALTTASTE gedrückt, und 
drücken Sie wiederholt auf eine der Pfeiltasten 

Markieren einer Spalte Klicken Sie auf die obere oder untere Zelle der 
Spalte, und drücken Sie wiederholt die NACH-
OBEN- oder NACH-UNTEN-TASTE 

Erweitern einer Markierung (oder eines Blocks) Drücken Sie STRG+UMSCHALT+F8, und 
verwenden Sie dann die Pfeiltasten; um den 
Markierungsmodus aufzuheben, drücken Sie 
ESC 

Verkleinern des Markierungsumfangs UMSCHALT+F8 

Markieren einer gesamten Tabelle ALT+5 auf der Zehnertastatur (bei deaktivierter 
NUM-TASTE) 

Erweitern einer Markierung  

Beschreibung Was ist zu tun ? 

Erweiterungsmodus aktivieren F8 

Wort markieren 2 Mal F8 
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Satz markieren 3 Mal F8 

Absatz markieren 4 Mal F8 

Alles markieren 5 Mal F8 

Nächstes Zeichen markieren Drücken Sie F8 und dann die NACH-LINKS- oder 
NACH-RECHTS-TASTE 

Markierung vergrößern F8 (einmal zur Markierung eines Wortes, zweimal 
zur Markierung eines Satzes usw.) 

Markierung verkleinern UMSCHALT+F8 

Erweiterungsmodus deaktivieren ESC 

Verschieben der Einfügemarke  

Beschreibung (Richtung) Was ist zu tun ? 

Ein Zeichen nach links NACH-LINKS-TASTE 

Ein Zeichen nach rechts NACH-RECHTS-TASTE 

Ein Wort nach links STRG+NACH-LINKS 

Ein Wort nach rechts STRG+NACH-RECHTS 

Ein Absatz nach oben STRG+NACH-OBEN 

Ein Absatz nach unten STRG+NACH-UNTEN 

Eine Zelle nach links (in einer Tabelle) UMSCHALT+TAB 

Eine Zelle nach rechts (in einer Tabelle) TAB 

Eine Zeile nach oben NACH-OBEN-TASTE 
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Eine Zeile nach unten NACH-UNTEN-TASTE 

An das Zeilenende ENDE 

An den Zeilenanfang POS1 

An den oberen Rand des Fensters ALT+STRG+BILD-AUF 

An den unteren Rand des Fensters ALT+STRG+BILD-AB  

Eine Bildschirmseite aufwärts (Bildlauf) BILD-AUF 

Eine Bildschirmseite abwärts (Bildlauf) BILD-AB 

An den Anfang der nächsten Seite STRG+BILD-AB 

An den Anfang der vorherigen Seite STRG+BILD-AUF 

An das Ende des Dokumentes STRG+ENDE 

An des Anfang des Dokumentes STRG+POS1 

Zur letzten Bearbeitungsstelle UMSCHALT+F5 

An die Position der Einfügemarke beim letzten 
Schließen des Dokumentes 

UMSCHALT+F5 

Wechseln zwischen verschiedenen Tabellenteilen 

Beschreibung (Wechseln zu) Was ist zu tun ? 

Nächste Zelle in einer Zeile TAB 

Vorherige Zelle in einer Zeile UMSCHALT+TAB 

Erste Zelle in einer Zeile ALT+POS1 
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Letzte Zelle in einer Zeile ALT+ENDE 

Erste Zelle in einer Spalte ALT+BILD-AUF 

Letzte Zelle in einer Spalte ALT+BILD-AB 

Vorherige Zeile NACH-OBEN-TASTE 

Nächste Zeile NACH-UNTEN-TASTE 

Einfügen von Absätzen und Tabstopzeichen in eine Tabelle  

Beschreibung Was ist zu tun ? 

Einzufügende Elemente  Taste(nkombination) 

Neue Absätze in eine Zelle EINGABETASTE 

Tabstopzeichen in eine Zelle STRG+TAB 

Überprüfen von Dokumenten 

Beschreibung Was ist zu tun ? 

Kommentar einfügen ALT+STRG+M 

Korrekturmarkierungen ein- oder deaktivieren STRG+UMSCHALT+E 

Einfügemarke an den Anfang eines Kommentars 
verschieben 

STRG+POS1 

Einfügemarke an das Ende eines Kommentars 
verschieben 

STRG+ENDE 

Durchführen eines Seriendrucks 

Beschreibung Was ist zu tun ? 
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Seriendruck-Vorschau ALT+UMSCHALT+K 

Zusammenführen eines Dokumentes ALT+UMSCHALT+N 

Drucken der zusammengeführten Dokumente ALT+UMSCHALT+M 

Bearbeiten eines Dokumentes mit 
Seriendruckdaten 

ALT+UMSCHALT+E 

Einfügen eines Seriendruckfeldes ALT+UMSCHALT+F 

kopieren des Bildschirms / des aktiven Dialogfensters in die 
Zwischenablage 

Beschreibung Was ist zu tun ? 

Aktuellen Bildschirm DRUCK-TASTE 

Aktiviertes Dialogfenster ALT + DRUCK-TASTE 

  

Drucken und Anzeigen von Dokumenten 

Beschreibung Was ist zu tun ? 

Drucken eines Dokumentes STRG+P 

Wechseln zur Seitenansicht ALT+STRG+I 

Verschieben der Einfügemarke in der 
vergrößerten Seitenansicht 

Pfeiltasten 

Wechseln zur vorherigen oder nächsten Seite bei 
verkleinerter Seitenansicht 

BILD-AUF oder BILD-AB 

Wechseln zur ersten Seite bei verkleinerter 
Seitenansicht 

STRG+POS1 
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Wechseln zur letzten Seite bei verkleinerter 
Seitenansicht 

STRG+ENDE 

Arbeiten mit Feldern 

Beschreibung (Einzufügendes Feld) Was ist zu tun ? 

DATUM ALT+UMSCHALT+D 

LISTENNR ALT+STRG+L 

SEITE ALT+UMSCHALT+P 

ZEIT ALT+UMSCHALT+T 

Leeres Feld STRG+F9 

Beschreibung Was ist zu tun ? 

Verknüpfte Daten in einem Word-Quelldokument 
aktualisieren 

STRG+UMSCHALT+F7 

Markierte Felder aktualisieren F9 

Feldverknüpfung aufheben STRG+UMSCHALT+F9 

Zwischen der Feldfunktion und dem Ergebnis 
wechseln 

UMSCHALT+F9 

Zwischen allen Feldfunktionen und den 
Ergebnissen wechseln 

ALT+F9 

Ausführen einer GEHEZU- oder 
MAKROSCHALTFLÄCHE vom Feld mit den 
Feldergebnissen aus 

ALT+UMSCHALT+F9 

Wechseln zum nächsten Feld F11 
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Wechseln zum vorherigen Feld UMSCHALT+F11 

Sperren eins Feldes STRG+F11 

Freigeben eines Feldes STRG+UMSCHALT+F11 

Arbeiten mit einer Dokumentgliederung 

Beschreibung (In der Gliederungsansicht) Was ist zu tun ? 

Absatz höherstufen ALT+UMSCHALT+NACH-LINKS 

Absatz tieferstufen ALT+UMSCHALT+NACH-RECHTS 

In Textkörper umwandeln STRG+UMSCHALT+N 

Markierte Absätze nach oben verschieben ALT+UMSCHALT+NACH-OBEN 

Markierte Absätze nach unten verschieben ALT+UMSCHALT+NACH-UNTEN 

Text unter der Überschrift einblenden ALT+UMSCHALT+PLUS 

Text unter der Überschrift ausblenden ALT+UMSCHALT+MINUS 

Gesamten Text oder alle Überschriften ein- bzw. 
ausblenden 

ALT+UMSCHALT+A oder Sternchen (*) auf der 
Zehnertastatur 

Zeichenformatierung aus- oder einblenden Schrägstrich (/) auf der Zehnertastatur 

Erste Zeile des Textkörpers oder gesamten 
Textkörper anzeigen 

ALT+UMSCHALT+L 

Alle Überschriften mit der Formatvorlage 
Überschrift 1 anzeigen 

ALT+UMSCHALT+1 

Alle Überschriften bis zu Überschrift n anzeigen ALT+UMSCHALT+n 

Tasten für Menüs 
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Beschreibung Was ist zu tun ? 

Einblenden des Kontextmenüs UMSCHALT+F10 

Aktivieren der Menüleiste F10 

Einblenden des Programmsymbol-Menüs (in der 
Titelleiste des Programms) 

ALT+LEERTASTE 

Auswählen des nächsten oder vorherigen Befehls 
im Menü oder Untermenü  

NACH-UNTEN-TASTE bzw. NACH-OBEN-
TASTE (bei eingeblendetem Menü bzw. 
Untermenü) 

Auswählen des linken bzw. rechten Menüs; oder, 
bei eingeblendetem Untermenü, Wechseln 
zwischen dem Haupt- und Untermenü 

NACH-LINKS-TASTE bzw. NACH-RECHTS-
TASTE 

Auswählen des ersten oder letzten Befehls im 
Menü oder Untermenü 

POS1 bzw. ENDE 

Gleichzeitiges Schließen des eingeblendeten 
Menüs und Untermenüs 

ALT 

Schließen des eingeblendeten Menüs; oder, bei 
eingeblendetem Untermenü, nur Schließen des 
Untermenüs 

ESC 

Tip Sie können alle Menübefehle in der Menüleiste oder auf einer eingeblendeten 
Symbolleiste mit der Tastatur auswählen. Drücken Sie ALT, um die Menüleiste zu 
aktivieren. (Um anschließend eine Symbolleiste zu aktivieren, drücken Sie STRG+TAB; 
drücken Sie diese Tastenkombination, bis die gewünschte Symbolleiste ausgewählt ist.) 
Drücken Sie den Buchstaben, der im Namen des Menüs mit dem gewünschten Befehl 
unterstrichen ist. Drücken Sie im eingeblendeten Menü den Buchstaben, der im Namen 
des gewünschten Befehls unterstrichen ist. 

Tasten für Symbolleisten 

Beschreibung (auf einer Symbolleiste) Was ist zu tun ? 
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Aktivieren der Menüleiste F10 

Auswählen der nächsten oder vorherigen 
Symbolleiste 

STRG+TAB bzw. STRG+UMSCHALT+TAB 

Auswählen der nächsten oder vorherigen 
Schaltfläche bzw. des nächsten oder vorherigen 
Menüs auf der Symbolleiste 

TAB bzw. UMSCHALT+TAB (wenn eine 
Symbolleiste aktiv ist) 

Öffnen eines Menüs EINGABETASTE (wenn ein Menü auf einer 
Symbolleiste ausgewählt ist) 

Ausführen der einer Schaltfläche zugewiesenen 
Aktion  

EINGABETASTE (wenn eine Schaltfläche 
ausgewählt ist) 

Eingeben von Text in ein Textfeld EINGABETASTE (wenn das Textfeld ausgewählt 
ist) 

Auswählen einer Option aus dem Dropdown-
Listenfeld oder Dropdown-Menü einer 
Schaltfläche  

Pfeiltasten, um zwischen den Optionen in der 
Liste oder im Menü zu wechseln; 
EINGABETASTE, um die gewünschte Option 
auszuwählen (wenn ein Dropdown-Listenfeld 
ausgewählt ist) 

Tasten für Fenster, Dialogfelder und Textfelder 

Fenster 

Beschreibung (in einem Fenster) Was ist zu tun ? 

Wechseln zum nächsten Programm ALT+TAB 

Wechseln zum vorherigen Programm ALT+UMSCHALT+TAB 

Einblenden des Windows-Menüs Start STRG+ESC 

Schließen des aktiven Dokument-fensters STRG+W 
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Wiederherstellen des aktiven Dokumentfensters  STRG+F5 

Wechseln zum nächsten Dokumentfenster STRG+F6 

Wechseln zum vorherigen Dokumentfenster STRG+UMSCHALT+F6 

Ausführen des Befehls Verschieben  STRG+F7 

Ausführen des Befehls Größe ändern STRG+F8 

Minimieren des Dokumentenfensters STRG+F9 

Maximieren des Dokumentfensters STRG+F10 

Auswählen eines Ordners im Dialogfeld Öffnen 
oder Speichern unter (Menü Datei) 

ALT+0, um die Ordnerliste auszuwählen; 
Pfeiltasten, um einen Ordner auszuwählen 

Auswählen einer Symbolleisten-Schaltfläche im 
Dialogfeld Öffnen oder Speichern unter (Menü 
Datei) 

ALT+ Zahl (1 ist die Schaltfläche links außen, 2 
die nächste Schaltfläche usw.) 

Aktualisieren der im Dialogfeld Öffnen oder 
Speichern unter (Menü Datei) angezeigten 
Dateien 

F5 

Dialogfelder  

Beschreibung (in einem Dialogfeld) Was ist zu tun ? 

Wechseln zur nächsten Registerkarte im 
Dialogfeld STRG+TAB bzw. STRG+BILD 

AB 

Wechseln zur vorherigen Registerkarte im 
Dialogfeld STRG+UMSCHALT+TAB bzw. 
STRG+BILD 

  

AUFWechseln zur nächsten Option oder TAB 
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Optionsgruppe 

Wechseln zur vorherigen Option oder 
Optionsgruppe 

UMSCHALT+TAB 

Wechseln zwischen Optionen im ausgewählten 
Dropdown-Listenfeld oder zwischen einigen 
Optionen in einer Optionsgruppe  

Pfeiltasten 

Ausführen der einer ausgewählten Schaltfläche 
zugewiesenen Aktion; Aktivieren oder 
Deaktivieren des Kontrollkästchens 

LEERTASTE 

Wechseln zu einer Option in einem 
DropdownListenfeld über den ersten Buchstaben 
im Optionsnamen 

Buchstabentaste für den ersten Buchstaben des 
Namens der gewünschten Option (wenn ein 
DropdownListenfeld ausgewählt ist) 

Auswählen der Option oder Aktivieren bzw. 
Deaktivieren des Kontrollkästchens über den im 
Optionsnamen unterstrichenen Buchstaben 

ALT+ Buchstabentaste 

Öffnen eines Dropdown-Listenfeldes ALT+NACH-UNTEN-TASTE (wenn ein 
Dropdown-Listenfeld ausgewählt ist) 

Schließen eines Dropdown-Listenfeldes ESC (wenn ein Dropdown-Listenfeld ausgewählt 
ist) 

Ausführen der Aktion der Standard-Schaltfläche 
im Dialogfeld 

EINGABETASTE 

Abbrechen des Befehls und Schließen des 
Dialogfeldes 

ESC 

Textfelder 

Beschreibung (in einem Textfeld) Was ist zu tun ? 

Verschieben der Einfügemarke an den Anfang POS1 
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des Eintrags 

Verschieben der Einfügemarke an das Ende des 
Eintrags 

ENDE 

Verschieben der Einfügemarke um ein Zeichen 
nach links oder rechts 

NACH-LINKS-TASTE bzw. NACH-RECHTS-
TASTE 

Verschieben der Einfügemarke um ein Wort nach 
links oder rechts 

STRG+ NACH-LINKS-TASTE bzw. 
STRG+NACH-RECHTS-TASTE 

Markieren von der Einfügemarke bis zum Anfang 
des Eintrags 

UMSCHALT+POS1 

Markieren von der Einfügemarke bis zum Ende 
des Eintrags 

UMSCHALT+ENDE 

Markieren bzw. Aufheben der Markierung eines 
Zeichen links neben der Einfügemarke  

UMSCHALT+NACH-LINKS-TASTE 

Markieren bzw. Aufheben der Markierung eines 
Zeichen rechts neben der Einfügemarke 

UMSCHALT+NACH-RECHTS-TASTE 

Markieren bzw. Aufheben der Markierung eines 
Wortes links neben der Einfügemarke 

STRG+UMSCHALT+NACH-LINKS-TASTE 

Markieren bzw. Aufheben der Markierung eines 
Wortes rechts neben der Einfügemarke 

STRG+UMSCHALT+NACH-RECHTS-TASTE 

Arbeiten mit Web-Seiten 

Beschreibung Was ist zu tun ? 

Hyperlink einfügen STRG+J 

Zur vorherigen Seite wechseln ALT+NACH-LINKS 

Zur nächsten Seite wechseln ALT+NACH-RECHTS 
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Aktualisieren F9 

Arbeiten mit Querverweisen, Fußnoten und Endnoten 

Beschreibung Was ist zu tun ? 

Inhaltsverzeichniseintrag festlegen ALT+UMSCHALT+O 

Indexeintrag festlegen ALT+UMSCHALT+X 

Fußnote einfügen ALT+STRG+F 

Endnote einfügen ALT+STRG+E 

Verwendung des Office-Assistenten 

Beschreibung Was ist zu tun ? 

Die Sprechblase des Office-Assistenten 
aktivieren 

ALT+F6 

Ein Hilfethema aus den im Office-Assistenten 
angezeigten Themen auswählen 

ALT+Themennummer (wobei 1 für das erste, 2 
für das zweite Thema steht usw.) 

Weitere Hilfethemen anzeigen ALT+ NACH UNTEN 

Vorherigen Hilfethemen anzeigen ALT+ NACH OBEN 

Eine Meldung des Office-Assistenten schließen ESC 

Hilfe vom Office-Assistenten anfordern F1 

Den nächsten Tip anzeigen ALT+N 

Den vorhergehenden Tip anzeigen ALT+B 

Tips schließen ESC 
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Den Office-Assistenten in einem Assistenten ein- 
oder ausblenden 

TAB, um die Office-Assistent-Schaltfläche 
auszuwählen; LEERTASTE, um den Assistenten 
ein- oder auszublenden 

  

Funktionstasten 

  Funktionstaste UMSCHALTTASTE STRG STRG+UMSCHALT ALT ALT+UMSCHALT 

F1 Hilfe oder 
OfficeAssistent 

Kontext bezogene 
Hilfe oder Anzeigen 
der Formatierung 

    Wechseln zum 
nächsten Feld 

Wechseln zum vorh
Feld 

F2 Verschieben von 
Text oder 
Grafiken 

Kopieren von Text Befehl 
Seitenansicht 
(Menü Datei) 

    Befehl Speichern (M
Datei) 

F3 Einfügen eines 
AutoTextEintrags  

Ändern der Groß-
/Kleinschreibung 
von Buchstaben 

Verschieben in die 
Sammlung 

Einfügen des 
Sammlungsinhaltes 

Erstellen eines 
AutoText-Eintrags 

  

F4 Wiederholen der 
letzten Aktion 

Wiederholen einer 
Suchen- oder 
Gehe zu-Aktion 

Schließen des 
Fensters 

  Beenden von Word Beenden von Word

F5 Befehl Gehe zu 
(Menü 
Bearbeiten) 

Wechseln zur 
letzten 
Bearbeitungsstelle 

Wiederherstellender 
ursprünglichen 
Größe des 
Dokumentfensters 

Bearbeiten einer 
Textmarke  

Wiederherstellen der 
ursprünglichen 
Größe des 
Programmfensters 

  

F6 Wechseln zum 
nächsten 
Ausschnitt 

Wechseln zum 
vorherigen 
Ausschnitt 

Wechseln zum 
nächsten Fenster 

Wechseln zum 
vorherigen Fenster  

    

F7 Befehl 
Rechtschreibung 
(Menü Extras) 

Befehl Thesaurus 
(Menü Extras) 

Befehl Verschieben 
(Systemmenü) 

Aktualisieren von 
verknüpften Daten 
in einem 
WordQuelldokument

Suchen des 
nächsten 
falschgeschriebenen 
Wortes 
(Automatische 
Rechtschreibprüfung 
aktiviert) 

  

F8 Erweitern der Verkleinern der Befehl Größe Erweitern der Ausführen eines   
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Markierung  Markierung  ändern 
(Systemmenüdes 
Dokumentes) 

Markierung (Block) Makros 

F9 Aktualisieren der 
markierten 
Felder 

Wechseln 
zwischen einer 
Feldfunktion und 
dem Ergebnis 

Einfügen eines 
leeren Feldes 

Aufheben der 
Verknüpfung eines 
Feldes 

Wechseln zwischen 
allen Feldfunktionen 
und den 
Ergebnissen 

Ausführen von GEH
oder 
MAKROSCHALTFL
vom Feld mit den 
Ergebnissen 

F10 Aktivieren der 
Menüleiste 

Anzeigen eines 
Kontextmenüs 

Maximieren des 
Dokumentfensters 

Aktivieren des 
Lineals 

Maximieren des 
Programmfensters 

  

F11 Wechseln zum 
nächsten Feld  

Wechseln zum 
vorherigen Feld  

Sperren eines 
Feldes 

Freigeben eines 
Feldes 

Anzeigen von Visual 
Basic-Code 

  

F12 Befehl Speichern 
unter (Menü 
Datei) 

Befehl Speichern 
(Menü Datei) 

Befehl Öffnen 
(Menü Datei) 

Befehl Drucken 
(Menü Datei) 

    

• * gefolgt von einem Leerzeichen und einem beliebigen Wort/Satz  

• 1, a oder A gefolgt von einem Punkt ( . ) oder einer rechten Klammer ( ) ) dann Leertaste 
und etwas geschriebenes  

• Gesamte Tastaturkombinationen finden Sie auch in der Microsoft Hilfe 

 
 


